Microsoft Word 2010

SIG Class #1, December 5%, 2011
Formatting the Base Document




Editing Functions

Word 2010 Views

Backstage

New Document — Templates
Navigation Pane

Setting TABs - Ruler

Formatting
* Themes

* Styles

* Drop Caps
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* Fonts, Size, Color, Indent, Bullets
Building Blocks — Quick Parts
Text Boxes — Linking
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References

* Word 2007 guide: Word 2003 to Word 2007 interactive
command reference guide

e http://www.microsoft.com/download/en/search.aspx?q=inter
active+-+word+2003

* Free Guide from Microsoft
* http://office.microsoft.com/en-us/training-FX101782702.aspx

* GFC Learning Free.org (Goodwill Community Foundation
International

* http://www.gcflearnfree.org/office
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Word 2010 Views

Print Layout —Click View Tab and select
“Print Layout” or Click the Icon at the
Bottom of the page

Word 2010 SIG Document Final Pro
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Lorem ipsum dolor sit amet® Q
onssctetuer adipisdng elit. Maecenas porttitor congue massa. Fuscs po: — (\‘ Q
magna szd pulvinar ultrides, purus lectus malesuada libero, sit amet comm . @ HEMEL P — 53% \—/ U;! o

&ros quisurna. I\umvlvenamperdmtemml’usaeest‘\.ﬁvanmsate]lus F — i —

habitant marbi tristique senectus et netus et malesuada fames ac
nonummy pede. Maurisetord.

Drae Cap, ot be formatted — Select
Drge Capfram the Irsert Tk

T tegstnanfly e e e FUIl Screen Reading
]D:Ipmhummath:\, nunc. _atsemverlﬁwtsele:.ﬁerﬂ Tt nonum
a.h.quetpedenmpede Suspe'ndused.a.plbusbe-squema,gna Intz: Web Layout

Zem“:“:f‘“’l“’“f*‘g“““ﬂ o Outline
O s ozet dui. Aliquamerat volutpat. Sed Blorem B mumnc pe D ra ft
Proin nec avgue Zoom In/out

Quisque aliquam tempor magna BRSNS e
malesuada fames ac turpis egestas. Nunc acmagna. Mascenas odio dalor, vulputate
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Print Layout — Exactly what will be printed
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Word 2010 Views (cont'd)

Full Screen View — Show one or two pages in a more pleasing view.
Most controls are hidden — Zoom setting must be done before

Web Layout — The way the document will appear if display on a Web page

Outline — Use the outline level to display the document.
Useful to reorganize a document

12/5/2011

Draft — Plain text view. Show Page/Section break but not Header/Footer,
Pictures. Easier to enter text before formatting

condimentum, lgula. Munc lacus metus, posuere eget, lacinia su, varus quis, libero.
.......... A?adlpauwlpsumﬂtJale
elit. Mascenas porttitor congue massa. Fusce posuers, magna sed pulvinar ultricies, purus Page B rea k
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Section Break
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E Home Insert  Pagelayout References  Mailings  Review  View  Add-ins B ac kSt a g e iS accesse d

: Z:As Information about WordSig-Bas... IR Through the File TAB

\ D:AGuy\D- Documents\Word Documents\CB SIGs\WordSi.. The Tab re places the
&7 Open .
= — Office Button.
3 Close — = P o ' :
ermissions :
_ @ A Backstage contains tools BS
) Anyone can open, copy, and change any Lo . =
Drotect 1| P2t of this document. To Open, Save, Print, etc. B,
Recent D te Properties * . . =
i ... There is section for Info, )
New Mark as Final - : . (]
ﬁ Let readers know the document is final e i An d Rece nt FI Ies' E
< and make it read-only, Words 2438 . . c
Print a9 Encrypt with Password lare that it Total Edting Time 714 Mm:l-h IS'1S a ISO there that yo 3,
-—ﬂB Require a password to open this Title Word 20 1 )
Save B Send hecgid » 5 gt | “Open the Word Options. o
gs . . . T
Hel % Restrict Editing Comments Print preview Is now u nde °
e 1% Control what types of changes people h . . 8
B3 Addas * can make to this document. hidden Related Dates T e P rint section =
‘ . % Restrict Permission by People Last Modified 3/27/201 5
2] Options _© Grant people access while removing  * iy G g‘
; their ability to edit, copy, or print, YR TR o
B3 Exit ' Last Printed 3/27/201 =

»  Add a Digital Signature read
__Q Ensure the integrity of the document
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New Document -Template

To create a new document — Click “New” from the File TAB. Select “Blank Document”

H " ”
Or chose a template. Click “Create ]
S Available Templates Agenda
Home Inzert Page Layout Referenc e As Provided by: Microsoft C
en - fat Home » Agendas Download size: 10KB

d save P . Office.com Templat.. s | Rating: A A

Save As -

2 Open + Y Home B =

12/5/2011

=
n

Info = E‘

Agenda for Seminar

Recent Blank Blog pos % Send
document

New

d-Ins - _—

Print _Lj _& =

Computer Booters of Sun Lakes

ST Sample My templz
o templates
elp
Office.com Templ... e D

Download

—
~N
—

Templates from Microsoft Office



Navigation Pane
1| e 5 Web Layout [ Ruler Q{

[E outline

rint |Full Screen

yout | Reading &l Draft

[ Gridiines -0oJO View the navigation pane: Click View TAB

Vi Navigstion Pane Chack “Navigation Pane”

Document Views Show .
- There are several views
vigation W X e B rowse by Headings
arch Document 0 « u;: _Pellastesrr=Browse by Pages
= Pellentesque
- e Browse by Search results
~
o
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TAB Setting - Ruler

To Set Tabs you need to see the Ruler —Click the Tab stops on the ruler
Ruler icon at the top of the right scroll bar ] ﬁLffF”Tt?‘h stop iet'té‘rhth: Sr:?ﬂ r:rositi? of text
. . dl Wi €N run 1o e rngnt as you type.
To see the Vertical ruler — Open Options under 2] ACenter Tab siop sets h onorih
. . . enter 1ab siop 315 ne posion o e
The File Tab. In the Display section check Show middle of the fext. The text centers on this
Vertical Ruler (Will show only left of the page position as you type.
Where the Cursor is. E| A Right Tab stop sefs the right end of the text. [l
As you type, the text moves to the lefi. Q
[+] A Decimal Tab stop aligns numbers around a E
First set the type of Tab decimal point. Independent of the number of i
. digits, the decimal point will be in the same
Wh||e you hold the po|nter on the Tab you UE‘E!TTIEH l:haractt—:_tr only; you cannot use t.hE‘
. L decimal tab to align numbers around a different
Can see a vertical dotted line indicating the character, such as a hyphen or an ampersand
Position symbol.)
To remove a Tab, click on the Tab icon and drag [+] A Bar Tab stop doesn't position text. It inserts 2

vertical bar at the tab position.
It outside the ruler

You can also use the Paragraph Dialog Box under the Page Layout Tab.

Computer Booters of Sun Lakes
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TAB Setting, contd

\ ?

Left Tab aligned. On the Insert tab, the galleries include fems

—_ ‘ 2| 52 Center aligned that are designed
Tab stop position: Default tab stops: 524' 65 Decimal Tab
0.75" 0.5" - $69.43
0.75" A _
Pt Tab stops to be cleared:y, | ith the overall look of your document. &= Tabbar
> Right Tab aligned
-
Alignment . s
o Ogemer O igh To setup options, double 5
©peamal O gar Click on the TAB. The £
(@)
reacer Option windows opens
@ 1 Mone ™. *3—— .
O Leading Characters can set
se | [ cer | [ cearal | Or not for each Tab
\ 10
ook || cancel |




File Home Insert Page Layout References Mailings Review View Add-Ins
] n __1 Ly Onentation ~ *— Bre A Watermark = indent Spacing
""" A . 13 size - £3 Line Numbers = 3 Pag 5 0 s a0
Themes Margins
s &Q' _gl NN Columns - 2" Hyphenation - | L) Page Borders g0 a| 42i0
Built-In a | Page Background Paragraph
. =0 . - ‘ ;
Aa ] Aa |[aa F[Aa Y
snvens lll | soosae LTI ] | smnman
Office Adjacency Angles Apex
< = o
Aa |y Aa Jij | Aa f}||Aa_ |}
smamom LTI smenme (| | meawen
Apo!hecar} Aspec‘l Austin Black Tie
Aa_H[Aa_1][Aa ‘Aa
| mEmmam smsRen : smumam B
Civic Clarity Composite Concourse
y p— - This document reflects ¢
[\a } Aa Ad ' | Aa from Microsoft Office W
e 1 ] smsusm| | |memees| | shows many features avs
Couture Elemental Equity Essential user.
Y
Aa
----n  mmsus ------
Executive Flow Foundr) Gnid v

Reset to Theme from Template W O rd 2C

=) Browse for Themes..

=
u Save Current Theme...

Docume
Final Prc

From the Page Layout Tab, click the
Arrow under Theme. The gallery of
Themes opens. As you hover the mouse
pointer over a Theme, you see instantly
The effect. When satisfied, click on the
Theme icon.

Color, Font, effect are set. Each one
May be modified if desired (lcons

On the right of the Theme Icon.

12/5/2011
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Quick Style '
Select the text to be formatted Review  View  Addins a

I R = &
Open the Style ga“ery to Select a Style am s AaBbCcDd | AaBbCcDd AaBbCc AaBbCc
SR NI | T Normal | TNo Spacing Headng 1 Heading 2 9
For the selected text (paragraph styles "
. . ragraph . AaB aaBbcer acsbecod acsbecod | —
Have the paragraph signin frontof the name = . e s oo | =
. . . tas. Nunc ac mag N
Other styles are available (title, sub title, que cursus sagitt AaBbCcDc AaBbCeDe AoBbCcDd AaBbCcDe @
(@]
QUOte, etC.) i 0 s Intense Em. Strong Quote Intense Qu —
(gl == . Vivamus a mi. N AABECcDD  AABECCDD AABBCCDD AaBbCcDd o
o @ habitant morbi tr Subtle Refe.. Intense Ref.. Book Title ¥ ListParag. « E
te vitae sollicituc Save Selection as a New Quick Style_. =
(e % N I\ \NOe. = 5 lit urna, interdun #  Clear Fot:amng t 3
= g;z Edrt.mg ‘\L\ :1( ,: {’} ;; ey uis, tempus quis 4, apply Styles. g
A style Set » Default (Black and White) %
L olors > istinctive H
g = S I Style gallery of additional styles are under B
|7 foms legan E
 PeragraphSpacing > | gangy Change style and style set. 5
——— ;""m Individual setting for Colors, Fonts, and Paragraph §
Modern Spacing are available.
Newsprint
Perspective
Simple
Thatch [ 12 J
Tradtional




Formatting with Style -cont'd

lll.l.'.,'bl.iL,lb' IdILALIL LTI LD
agna. Maecenas odio
is felis.

C vuipumte augue magna

Style Pane Options

- N

LY I

Select styles to show:

e -

Select how list is sorted:

'| Select formatting to show as styles:
[] paragraph level formatting
[] Font formatting

[] Bullet and numbering formatting

Select how built-in style names are shown
Show next heading when previous level is used

|:| Hide built-in name when alternate name exists

'@:ﬁ' Only in this document '1:::1' New documents based on this template

Clicking the square below the Style change opens the

|As Recommended IEI I

Clear All i
Normal T
No Spacing 1|2
HEADING 1 12
HEADING 2 1a|
| TITLE 12
| SUBTITLE 13
|| Subtle Emphasis a
| EMPHASIS a _
Show Preview
|| Disable Linked Styles
' Options..

details of the current

Style. The options menu can be accessed from there too.

12/5/2011
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Inserting Drop Cap

Select the first character of a paragraph !

(A

A & QuickParts ~ & ~ TU Equation

Click Drop Cap to select. Drop Cap |- 4 wordat~ B §2 Symbol -
] ) - Tt G
Click Drop Cap Options to Fosition " gox- |A=DropCap-| 'é -
Format the character — N - oo -
: MNone Dropped In margin A:: Dropped R
'| Options 'nces ina __: .
Font: A ::; In margin é
4T || +BOd‘f |Z| — 3
[ . . = Drop Cap Options... 5
Lines to drop: ‘3 E‘ 1e massa. %)
////////If/////////; Distance o m e ‘Ulr E‘ modo maegna eros Ha
% ore = »
. ]
05 B
. Pe ok | [ camal | 8
é quis " @
\,/é tris’ %
g Ma 3
4 . . . . S
CTETTE S g port Example: Drop Cap in margin, Algerian font, 5 line =

Drop, .5 from Text

[14)




-
-_----: |ext Formatting

Paste Theme Fonts

o7 cambria

n o R = Font

B O ALERIAR Select Text, From Home Tab click down arrow
% Acace o Of the font name window. The effect is shown as
e You hover the mouse pointer over a name
 hard St Size

Same as above, but click down arrow of the font size

o - o Font can be increase or decrease by clicking 6 - A A

o & — = The large or small A next to the font number
) Calibri Body) -/M |- A

AP ] Other Icons allow to Bold, Italic, Underline,
10 Strikethrough, Sub/Super Script, Change Case/Color, Effect,

{reiics iy | 11

B Highlight or Clear

12/5/2011

14

. Paragraph
Paragraph text can be aligned left, right, center, or justified
Indent can be increased/decreased. Line spacing may be changed
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The 9 sign shows/hides paragraph mark/format symbols
Background shading and border maybe added. There is also a
Sort option (numeric or alphanumeric)

Bullet

Selected text maybe arranged in bullet type, numbered list or
Multilevel list
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Building Blocks/Quick Parts

Nord Options

General @ Change how Word corrects and formats your text.

i Quick Parts are building Blocks that are
- AutoCorrect options
Change how Word corrects and formats text as you type: | AutoCorrect Op prEformatted elements or User generated

Save
Language When correcting spelling in Microsoft Office programs e I e I I I e nts
Advanced Ignore words in UPPERCASE

Ignore words that contain numbers

Ignore Internet and file addresses

QEKACSTORST || ] g epet wrd Auto Correct: Text automatically
add-ns [C] Enforce accented uppercase in French

I suggestrom main dictonay only replaced for common mistakes

French modes: |Trad|"t|'ona\ and new spellingslzl

Customize Ribbon

12/5/2011

Spanish modes: |Tu‘teo verb forms only El

When correcting spelling and grammar in Word

Check spelling as you type

Use contextual spelling

Mark grammar errors as you type
Check grammar with spelling

D Show readability statistics

Writing Style: |Grammar Only lzl [ Settings... l
Check Document

Exceptions for: | Documentl IZ|
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[T Hide spelling errors in this document only

D Hide grammar errors in this document only




AutoCorrect Options

To see Word Proofing Option, click the
Backstage Tab (File), click Proofing. To see the
Auto Correct, click AutoCorrect Options

If you misspell a word often, you can type itin
the Replace space and type the correct spelling
in the With space. It will be added to the list of
AutoCorrect

AutoCorrect can also be used to insert text. For
example, to insert “Computer Booters of Sun
Lakes” | created an AutoCorrect entry for
Computer Booters of Sun Lakes to be replaced
by the Club Name. Every time | type “ cbsl “
the club name replaces that name

AutoCorrect: English {(U.5.)

AutoFormat

AutoCorrect

Math AutoCorrect

| Awr

Show AutoCorrect Options buttons

Correct TWo INitial CApitals

Capitalize first letter of sentences
Capitalize first letter of table cells
Capitalize names of days

Correct accidental usage of cAPS LOCK key

Replace text as you type

Replace:

With:

(@) Plain text

Formatted text

[@
(r) ®
(tm) ™
o 2
-( =
3] @

12/5/2011
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Building Blocks - Built-In

) Cover Page ~

Cover Page

In the Insert TAB, Pages group, click Cover Pag

Gallery. Select the desired cover page

Header/Footer
In the Inset TAB, Header/Footer
Group, click Header or Footer
To see the gallery

Add-ins

erfink
kmark

ss-reference

ctoseete

Blank (Three Columns)

o vt

Alphabet

[Type the document tie}

Annual

[Type the document title] | [Ye

v

Built-In

unEll

ﬂ

rage Layuun

| BE [F) .

ETET ETILES

&= [Year]

12/5/2011

e e

Austin

Conservative

© More Cover Pages from Office.com

;;g Remove Current Cover Page

i

Computer Booters of Sun Lakes
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Building Blocks-Built-In cont'd

Page Number

To insert just a Header or Footer with only page
number, click the Page Number icon in the Header and
Footer group. Select the position and format

Text Box

In the Insert TAB, Text group, click Text Box.

The cursor blinks inside a dotted line box. You may
start typing and the box will expand as needed. You can
resize the box later

N Al _-:l A A & Signatu
2 .
2] — 2 Oate &
Page Text  Quick Wordart
Number = Sox~ Parts ~ " Object
2 JIop of Page
2 Bottom of Page » Simple
=l Page Margins »  Plain Number 1
2)  Current Position
;T format Page Numbers
X Remave Page Numbers
Plain Number 2
A A4 AR Biverim " Plain Number 3
- B S & Yo f
ot

12/5/2011
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Quick Parts

To see all Building Blocks, in the Insert TAB, Text group
Click Quick Parts Icon 1| T 4 A= B

55 Date & Teme
Quick |Wordan

~ |pas = "4 Object -
— . General
Building Blocks Organizer :mul
Building blocks: Click a _ Emnhum
MName Gallery Category Template : C||Ck BU ||d|ng BIOCk Era put m:m;- Lk
Gel AutoText General MNormal.d... .
Guy AutoText  General Normal.d... Orga nizer tO see the
chsl AutoText  General Mormal.d... C :
omplete list (standard aRd
Bibliogra.. Bibliogr.. Built-In Built-In B... p ( B autoTen
Works Cit.. Bibliogr.. Built-In Built-In B... custom generated B Document Property
Austin Cover Pa.. Built-In Built-In B... . - i
“  Fiedd_
Conserva.. Cover Pa.. Built-In Built-In B... CIICk on a name to See the
. Building Blacks Organizer...
Perspecti.. Cover Pa.. Built-In Built-In B... p review
A
Cubicles  Cover Pa.. Built-In Built-In B...
Transcend Cover Pa.. Built-In Built-In B...
Tiles Cover Pa.. Built-In Built-In B...
Fynosure  Cover Pa.. Built-Tn Built-Tn B...




Creating a Quick Part

Type the text you want to be a Quick Part — it can be a single word, a paragraph,
A Logo/Picture, an Address, etc.
Select the typed text formatted exactly as you want to seeit. s ;g g 2 s

= [ Date & Time

In the Insert TAB, Text Group expand Quick Parts and click bor- [patse] o cap - "WOBRG- _
to “save the selection” = 3
- S
g Eheorat LN
Me-mberidip Dvector S~
_ an P 5
mE ; —— &
A"'Fhﬂd? ¥ auvtotent E
1245 E. Dobson Rd. ( S @ DoomentMropery 5
Chandler A?_ 85243 Create New Building Block i, ? ()
¥ == bed ua
Name: oy Building Blocks Organizer. a2
Give it Name you will remember Gallery: | quick Parts \“ Seectonto Quick P Gtey g
CIiCk OK Category: General c?
Description: %
o
Save in: Building Blocks.dotx §

Options: Insert content only
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N
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Using Custom Quick Part

In your document type the saved Name of the custom created Quick Part
Press Function Key 3 (F3) and the saved text/logo/picture/etc. is
Inserted at the cursor position

Anybody
anyb dy| 1245 E. Dobson Rd.
Chandler, AZ 85248
= '~ F, Date & Time £2 Gym
Type name Press F3 Text inserted — —
" Anybody

Anybody
1245 £ Dobuos Rd
iChandier, A7 RSB

Quick Part can be inserted in other part of the

Insent ot Current Document Posai

Document. Open the Quick Part gallery and right i ot Page Header
click the Thumbnail. Select the position from the _ e et i
Iist o Insent at Epd of Secvon

Mo e g Iirectc

i:::'_:::“’ frsent at fegnning of Documen

lsen st End of Docurmsent

ECMt Propenies

4 Qrgange and Delete.
N AvtoTen
Add Gaflery 1o Quack Access Tool
1 e L —

= Feld

B sulding Slocks Organizer.

12/5/2011
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Text Boxes - Linking

Insert Tab, Text Box (create two). Start

typing text in first box. . B .
W|th cursor in the fl rSt bOX Under Drawing Page Layout References Mailings Review View Add-Ins
4
. . . D shape Fill ~ PR |l Text Direction ~
tab, click link. The cursor become a Pitcher. a 2] G Shope utine: A e
. P T uick ;
Move it to second box (Must be empty) and ?peeﬁmt S % Break Link
click. The two boxes are now linked. e F T I ey
Text typed in the first will overflow to the ' ' |
second one 19 ) e > E
Presets
ngfquat qu () o, |
. . | glow »
By default the text box is rectangular. This | L
can be changed K Utmy | SoftEdges
. g ”telera/
i {

Selt?ct the text box, in the format tab, select 'elfzhmf;”"’“‘f (5] nei ’ ‘_l J
options from Shape Effects O i , |

Pretiym, L/ — & 3-D Options...

Woecen,. " €Usm, || 3-DRotation » e

/ﬁ(lta(e. _"‘{?Ug W — - - .

D"""Qua,,,::' e L
4 eget mauris.
felis.

aniam vel nihh Cras



